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Purpose

Purpose
This document describes how to install and integrate the following Portrait Software applications and
components:
•
•
•
•
•
•

Portrait Foundation 4.4 Update 4
Portrait Interaction Optimizer 5.5
Portrait Dialogue 6.0
Portrait Shared Server 2.0
Portrait Explorer 4.0
Portrait Miner 7.0A

Note: Installation of third party applications such as SharePoint and SQL Server are not included in
this guide, they are simply listed as platform prerequisites.
Note: If you need to install a single Portrait product, refer to the install guide on the relevant release
media. This guide should only be used when installing multiple Portrait software applications.

Intended audience
This guide is provided for System Administrators who intend to install the Portrait Suite of applications.
No assumptions are made regarding prior knowledge of third party or Portrait Software applications.
However, this document assumes familiarity with administration of target systems, as well as appropriate
levels of access to those systems.

Related documentation
Document

Media (zip/dvd) and location

• Portrait Interaction Optimizer 5.5 Install- • Interaction Optimizer media in: \Documentation\
ation Guide

• Portrait Foundation Installation Guide • Foundation media in: \Software\Documentation\Installation\
4.4 Update 4
• Foundation media in: \Software\Documentation\Database\
• Portrait Foundation Database Installation Guide v23.2

8

Portrait Suite 1.0

Chapter 1: Introduction
Document

Media (zip/dvd) and location

• Portrait Dialogue 6.0 Server Installation Guide

• Dialogue media in: \Documentation\1 - Installation & upgrade\

• Portrait Miner 7.0A Administration
Guide

• Miner media in: \server\Components\server\qs6.1A\documentation\

• Portrait Explorer 4.0 Installation Guide • Miner media in: \Documentation\

Tip: All documents are also available on Portrait Software's support website: http://support.portraitsoftware.com
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Portrait Suite overview

In this section:
•
•
•
•
•
•

Portrait Dialogue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Interaction Optimizer . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Portrait Foundation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Portrait Explorer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
Portrait Miner . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
Portrait Shared Server . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
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Portrait Dialogue
Portrait Dialogue converts customer interactions into a connected two-way dialogue across all channels
for greater customer engagement. Unlike traditional campaign management systems which are optimized
for prospecting rather than managing the customer lifecycle, Portrait Dialogue provides pre-built, automated, multi-step phases which automate a dialogue as a two way conversation, resulting in reduced
internal workload, increased relevance, timeliness and engagement.
Interaction Optimizer (IO) can optionally use Portrait Dialogue components to administer users of Portrait
HQ. The components are the:
• Portrait Dialogue Server
• Portrait Dialogue Server API Web application
• Portrait Dialogue database.

Interaction Optimizer
Portrait Interaction Optimizer (IO) works with your existing customer applications to help convert inbound
customer interactions into revenue opportunities.
Interaction Optimizer helps provide targeted (1-to-1) sales, service and retention offers for individual
customers, at a specific moment of interaction, on any channel, for example web, inbound call, and
email. Interaction Optimizer offers intelligent point of customer interaction by leveraging an organization's
data in real-time to ensure the customer receives the right offer at the right time.
Portrait Interaction Optimizer enables customer data to be connected across different business units
and channels without duplication. Multiple customer channels (via marketing campaigns) can be managed
from a single view using Interaction Optimizer's HQ dashboard. Marketing campaigns can be added or
changed 'on the fly' for immediate impact, and a simulation capability allows marketers to perform rapid
'what if' analysis to determine the right campaign mix – before placing into production.

Portrait Foundation
Portrait Foundation is a highly configurable system for providing full circle Customer Relationship Management. Portrait Foundation provides a core set of functionality in the CRM server that is independent
of the channel by which a customer chooses to communicate with the organisation.
Interaction Optimizer (IO) uses Portrait Foundation to configure custom data retrieval processes to suit
your IO implementation. In addition, the IO web service is implemented using Portrait Foundation process
models.
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Portrait Explorer
Portrait Explorer is an easy-to-use, browser-based, customer data exploration tool. It allows business
users to access their customer data quickly and easily without the need for advanced analytical or statistical help.
Portrait Explorer allows business users to:
• search for customers or groups of customers across an enterprise
• drill down on individual customers to confirm their personal details and data
• use key selection criteria (age, sex, income) to expose customers and groups of customers for potential
review or campaign actions.

Portrait Miner
Portrait Miner is a powerful predictive analytics solution that enables customer insight professionals and
business users alike to achieve a clear picture of their customers for the purpose of greater understanding
and prediction of future behavior. Portrait Miner can be used to predict profit-impacting behaviors and
propensities, including customer churn, cross sell and up sell opportunities, campaign planning and
segmentation, customer satisfaction and loyalty, and customer lifetime value.
Interaction Optimizer (IO) uses Portrait Miner's analytic rule repository to hold analytic rules used to
score IO recommendations.

Portrait Shared Server
Portrait Shared Server consists of five key components:
• Portrait Shared Services (PSS). Provides the set of web services that allow Portrait Suite applications
(Portrait Explorer, Miner, Dialogue and Interaction Optimizer) to communicate with each other.
• Portrait Shared Repository (PSR). Provides the Portrait Shared Repository and Portrait Data
Warehouse databases.
• SharePoint Tasks (Optional). Provides an integrated task management solution where tasks assigned
to individuals in Portrait HQ are displayed in SharePoint for greater visibility. Note: SharePoint Tasks
is optional for Portrait Dialogue and Portrait Interaction Optimizer, and not required for Portrait Explorer.
• Portrait Reports (Optional). Provides a set of pre-built reports on the operational performance of
Portrait Interaction Optimizer and Portrait Dialogue. Note: Portrait Reports is optional for Portrait Dialogue and Portrait Interaction Optimizer, and not required for Portrait Explorer
• Portrait HQ. Provides a central dashboard for planning, launching and monitoring large scale (1 to 1)
marketing campaigns. In addition to providing live (up-to-the-minute) summary views of your overall
marketing position, Portrait HQ also provides real-time data enabling you to evaluate campaign progress
and take immediate action if required.

Portrait Suite Installation Guide
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Suite installation options

In this section:
• Portrait Suite - compatibility . . . . . . . . . . . . . . . . . . . . . . .16
• Suite installation notes . . . . . . . . . . . . . . . . . . . . . . . . . . .16
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Portrait Suite - compatibility
The Portrait Suite has the following version compatibility:
Software

Software level

Portrait Foundation

4.4 Update 4

Portrait Dialogue

6.0

Portrait Miner

7.0A

Interaction Optimizer

5.5

Portrait Shared Server

2.0

Portrait Explorer

4.0

Suite installation notes
• The Portrait Shared Server (PSS) is a shared component which must always be installed
• Portrait Miner, Portrait Explorer, Portrait Interaction Optimizer and Portrait Dialogue can be added in
any combination
Note: The instructions provided in this document guide you through a complete suite install. However:
• If you only want to install 2 or 3 of the Portrait products, you can still use this guide and follow
the procedures of the products you are interested in
• If you only want to install a single product, it is recommended that you use the single product
installation guide included on your release media.
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In this section:
• Installation overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
• Installation pre-requisites . . . . . . . . . . . . . . . . . . . . . . . . .18
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Installation overview

Installation overview
To install the Portrait Suite, complete the procedures listed below.
Installation procedure

Time estimate

1. Configuring your servers on page 22

20m

2. Installing Portrait Shared Server on page 25

20m

3. Installing Portrait Foundation components on page 48

30m

4. Installing Portrait Dialogue on page 37

15m

5. Installing Interaction Optimizer on page 47

20m

6. Installing Portrait Explorer on page 61

10m

7. Installing Portrait Miner on page 65

10m

Important: This guide takes you through installing the Portrait Suite of products. If you want to install
a single Portrait product, see the relevant application install guide.

Installation pre-requisites
The Portrait Suite installation procedures assume the following software has been installed.
Server

Applies to

Software and Version

• All

• All Portrait products

• Microsoft Windows Server 2012 Standard or Enterprise
Editions, or
• Microsoft Windows Server 2008 R2 Standard or Enterprise
Editions

• All Portrait products

• Microsoft .NET Framework v4.5
• Microsoft .NET Framework v4.0 (only required for Portrait
Foundation servers)
• Microsoft .NET Framework v3.5 (only required for Portrait
Dialogue servers)

• All Portrait products

• Microsoft SQL Server 2008 R2 SP1, or
• Microsoft SQL Server 2012

• Database
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Server

Applies to

Software and Version
Supported in either 32-bit or 64-bit, for Standard and Enterprise Editions, and either case-sensitive or case-insensitive
master databases. The following features must be installed:
•
•
•
•
•
•

• Portrait Dialogue

Database Engine Services
Management Tools - Basic
Management Tools - Complete
Client Tools Connectivity
Microsoft SQL Server Integration Services
Microsoft SQL Server Reporting Services (optional)

• Oracle 11i R2
• For full Oracle Unicode support, the Oracle database
must be set up with Unicode character set. We recommend NLS_NCHAR_CHARACTERSET=AL16UTF16
and NLS_CHARACTERSET=AL32UTF8.
• If you don't plan to use full Unicode support, you can have
a non Unicode character set for NLS_CHARACTERSET,
for example WE8ISO8859P1. The character set you use
must support the « and » characters. This means for instance US7ASCII cannot be used.
• If you are using an Oracle database, then Oracle native
32-bit client drivers must be installed.
Note: If running in an 64-bit environment and Portrait Dialogue is using an Oracle database, then Oracle native
64-bit client drivers must be installed on the Portrait
Shared Server (PSS).

• Application

• Portrait Interaction
• Microsoft SQL Server Native Client
Optimizer
• Microsoft SQL Server feature: Client Tools Connectivity
• Portrait Dialogue
• Portrait Shared Server

• Interaction
Optimizer

• Portrait Interaction
Optimizer

• Microsoft Windows Installer 4.5
• Microsoft MSXML 6.0 SP1 or above
• Microsoft Visual C++ 2010(x86) Redistributable (installed
by Portrait installer if not present)
• Microsoft Primary Interoperability Assemblies 2005 (install
by Portrait installer if not present)

• SharePoint
(Optional)

• Portrait Dialogue
• Portrait Interaction
Optimizer

• Microsoft SharePoint Server 2013 (64-bit only), or
• Microsoft SharePoint Foundation 2013 (64-bit only)

Portrait Suite Installation Guide
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Server

Applies to

Software and Version

• Portrait Shared Server

• Report
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• Portrait Dialogue
• Microsoft SQL Server feature: Reporting Services
• Portrait Interaction
Optimizer
• Portrait Shared Server
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In this section:
• Configuring your servers . . . . . . . . . . . . . . . . . . . . . . . . . .22
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Configuring your servers
All servers
• Use Component Services to:
• Enable Distributed COM (see the Default Properties tab within My Computer Properties)
• Configure the local Distributed Transaction Coordinator to support Network DTC Access. Allow inbound and outbound transaction manager communication (see the Security tab within Local DTC
Properties)

Application servers
Use Server Manager to:
• Enable the Application Server role
• Enable the following services:
•
•
•
•
•
•
•
•
•

Application Server Foundation (on 32-bit machines only)
Web Server (IIS) Support
TCP Port Sharing
Windows Process Activation Service Support
Windows Process Activation Service Support > HTTP Activation
Windows Process Activation Service Support > Message Queueing Activation
Windows Process Activation Service Support > TCP Activation
Windows Process Activation Service Support > Named Pipes Activation
COM+ Network Access

Web servers
• Use the Server Manager to:
• Enable the Web Server role
• Enable the following services:
• Management Tools
• Management Tools > IIS 6 Management Capability
• Management Tools > IIS6 Management Compatibility > IIS 6 Metabase Compatibility
•
•
•
•

Management Tools > IIS6 Management Compatibility > IIS 6 WMI Compatibility
Management Tools > IIS6 Management Compatibility > IIS 6 Scripting Tools
Management Tools > IIS6 Management Compatibility > IIS 6 Management Console
Web Server > Security > Windows Authentication

• Web Server > Application Development > ASP.NET 4.5 (required for Interaction Optimizer and
Portrait HQ)
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• Enable the following features:
• Message Queueing

• If installing Portrait Dialogue on a 64-bit server, you must enable IIS to run 32-bit applications on 64bit Windows. To do this:
1. Open a command prompt and navigate to the %systemdrive%\Inetpub\AdminScripts directory.
2. Type the following command: cscript.exe adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64 1
3. Press ENTER.
Note: Ensure that the IIS application pool used to run the Dialogue Web Applications is configured with
a Managed Pipeline Mode of Classic. By default, Dialogue Web Applications use the DefaultAppPool application pool.

Database servers
• Use SQL Server Configuration Manager to:
• Verify that the SQL Server Agent service is running
• Ensure the Named Pipes and TCP/IP protocols are enabled (see Protocols for MSSQLSERVER
beneath SQL Server Netork Configuration)
• Use Component Services to configure the local Distributed Transaction Coordinator to support Network
DTC Access. Allow inbound and outbound transaction manager communication. (See Security tab
within Local DTC Properties)
Portrait HQ (PSS) servers
• Windows Powershell 2.0 is configured with an execution policy of RemoteSigned or Unrestricted
for the LocalMachine scope. (Use Set-ExecutionPolicy RemoteSigned -Scope LocalMachine.)

Portrait Suite Installation Guide
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Installing Portrait Shared
Server

In this section:
• Installation overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .26
• Before you begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .26
• Installation procedures . . . . . . . . . . . . . . . . . . . . . . . . . . .27

6
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Installation overview
Installation procedure

Time estimate

Deploying SharePoint (optional) on page 27

10m

Installing Portrait Shared Server on page 28

10m

Installing DWH SSIS packages on page 30

10m

Scheduling data warehouse updates on page 31

10m

Setting up HQ users on page 31

15m

Purging old and deleted data from the database on page 31

10m

Before you begin
Before starting the installation, ensure you:
• Plan your installation! The Portrait Shared Server installer provides the option to install all Portrait
Shared Server features on one server, or alternatively, install all features on separate servers via the
Custom Install option. You need to:
• Decide on which features you want to install. Note: The Task Management and Report features are
optional.
• Decide on which features you want to group together on the one server. For example, you might
want to set up a server with the Portrait Shared Server (PSS) and Portrait Shared Repository (PSR)
components. You may then want to install the Reports component on a separate Reports server
and the Task Management on a pre-existing SharePoint server.
Note: Just how you install the Portrait Shared Server and its four key components is up to you and
your server environment.
Note: The installation procedures that follow point you towards the Custom Install screen based
on the assumption you will want to install at least one feature on a separate machine.

• In IIS, ensure that the Default Web Site has an HTTP Site Binding on port 80. This binding only has
to be present whilst running the PSS installation; you can remove it after successfully installing Portrait
Shared Server.
• If you choose to use SharePoint with Portrait Shared Server, see SharePoint and Portrait Shared
Server installation considerations in the appendix.
• Collect all information required for the install. For more information, see the Installation Datasheets in
the appendix.
• Note the following install restrictions:
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• Portrait Shared Server must be installed on a machine that has SQL Server or SQL native client
installed.
• If your SharePoint server is separate to your PSS server, then you must install the SharePoint Tasks
feature before Portrait Shared Services.
• The SQL Server database must be configured with the TCP/IP protocol enabled if it is running on
a separate server from where you are installing the Portrait Shared Server
• You will need Administrator access on the machine where you are running the installer, and you will
need to be able to either provide sysadmin database credentials (by providing SQL Server authentication credentials for a sysadmin role) or selecting a user to whom the DBO role will be set after
the install. This user will be added to the list of SQL server logins.
• It is recommended that you use the same Windows account (username and password) to manage
the PSS application pool and connection to the PSR database. The account should:
• be on a network domain rather than a local machine
• have db_datareader and db_datawriter role permissions on the PortraitPSR database
• The MS DTC service must be running on the database server and Portrait HQ (PSS) server.
Note: The Portrait HQ installer automatically configures the Distributed Transaction Coordinator,
however, if your database server is a separate machine to your Portrait Shared Server installation, you need to manually configure MS DTC on that machine.

• Source all required software:
Software + documentation

Media location (zip file/dvd)

Portrait Shared Server software

Interaction Optimizer media in: \Portrait Shared Server\

Installation procedures
Deploying SharePoint (optional)
Portrait HQ use SharePoint to help manage tasks related to a marketing campaign. You can assign
tasks to individuals and then display them in SharePoint for greater visibility. Using SharePoint also enables task recipients to display their tasks in Microsoft Outlook.
To deploy the SharePoint solution:
1. Log on to your SharePoint server.
2. Run the setup.exe in the \Portrait Shared Server directory on your installation media (zipfile/DVD).
3. Accept the license agreement and default installation folder.
4. On the Installation Type screen, select Custom.

Portrait Suite Installation Guide
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5. On the Custom Setup screen, ensure that the SharePoint Tasks feature will be installed on the
local hard drive.
6. Click Install.
7. To verify that the solution package has been successfully deployed:
a) Go to SharePoint Central Administration.
b) Navigate to System Settings > Farm Management > Manage farm solutions
c) Verify PortraitSharedServerPortal.wsp is in the Deployed state.

Installing Portrait Shared Server
Portrait Shared Server includes four installation components: Portrait Shared Services (PSS), Portrait
Shared Repository (PSR), SharePoint Tasks, and Portrait Reports.
• Portrait Shared Services (PSS). Provides the set of web services that allow Portrait Suite applications
(Portrait Explorer, Miner, Dialogue and Interaction Optimizer) to communicate with each other.
• Portrait Shared Repository (PSR). Provides the Portrait Shared Repository and Portrait Data
Warehouse databases.
• SharePoint Tasks (Optional). Provides an integrated task management solution where tasks assigned
to individuals in Portrait HQ are displayed in SharePoint for greater visibility. Note: SharePoint Tasks
is optional for Portrait Dialogue and Portrait Interaction Optimizer, and not required for Portrait Explorer.
• Portrait Reports (Optional). Provides a set of pre-built reports on the operational performance of
Portrait Interaction Optimizer. Note: Portrait Reports is optional for Portrait Interaction Optimizer, and
not required for Portrait Explorer. If you want to optionally install Portrait Reports for Portrait Dialogue,
see the Installation of HQ Reports for Portrait Dialogue guide on the Portrait Dialogue release media.
Important: Portrait Shared Server can be installed with a single Portrait product such as Portrait Dialogue or Portrait Explorer, or it can be installed with multiple Portrait Suite products to enable
application integration. The following steps guide you through the install using the Custom
Install option where you can select or deselect options based on whether you are installing
single or multiple Portrait products.
1. Run the setup.exe in the \Portrait Shared Server directory on your installation media (.iso).
Ensure you right-click the setup.exe and select Run as Administrator.
2. Select the display language for your installation.
3. Click Next on the Welcome dialog.
4. Accept the license agreement and click Next.
5. Accept the default destination folder and click Next.
6. On the Installation Type screen, select Custom Install.
7. On the Custom Setup screen, click Portrait Shared Repository and Portrait Shared Services
and select This feature will be installed on local hard drive.
•

If you want to disable SharePoint Tasks (Optional) or Portrait Reports (Optional) for Portrait Dialogue or Interaction Optimizer, click the install component and select This feature will not be
available.

8. On the Database User properties screen, enter the user credentials for the Portrait Shared Repository and Data Warehouse databases.
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9. On the Database Server screen, select the database server that you are installing to. Edit the name
of the database catalog; if you want to change the Portrait Shared Repository database name from
the default of PortraitPSR. Note: The installer uses the login you specify on this screen to connect
to the database server and create or update the Portrait database. You must specify a login that has
at least the dbcreator server role.
10. On the Database Server screen, edit the name of the database catalog if you want to change the
Portrait Data Warehouse database name from the default of PortraitDW.
11. On the Web Site screen, ensure that the Default Web Site is selected as the Web Site. Choose
Create a new web site if you want to install the HQ into a new web site.
12. On the Application Pool properties screen, enter the user name and password of the account that
you want to use to run the HQ.
13. On the Portrait Analytics Web Services properties screen, check Enable Portrait Analytics Web
Services Integration if Portrait Explorer is one of the products you are installing. If not, uncheck this
option.
•

If you checked this option, enter your Portrait Analytics Web Services (PAWS) password. The
password you enter here must match the PAWS password you supply when installing Portrait
Analytics Web Services.You should accept the defaults for the URLs on this page.

14. On the Portrait Dialogue Service Properties screen, check Enable Portrait Dialogue integration
if Portrait Dialogue is one of the products you are installing. If not, uncheck this option.
•

If you checked this option, enter the URL of the Dialogue Server, and the name of the Dialogue
Server instance. Accept the default URL if the Dialogue Server is installed on the same server
as Portrait Shared Server.

15. On the Portrait SharePoint Services Properties screen, check the Enable SharePoint Integration
checkbox if Portrait Dialogue or Interaction Optimizer are products you are installing and you want
to use the SharePoint Tasks feature. If not, uncheck this option.
•

If you checked this option, enter the URL for the Portrait tasks site that you want the installer to
create for you. The URL you provide identifies which SharePoint site collection the Portrait tasks
site will be created in. This SharePoint site collection must already exist and use the Team Site
template. To create a new site collection in SharePoint:
• Launch SharePoint Central Administration
• Select Application Management > Create site collections
• Enter the title Team Site for the site collection. Note: The site collection must be named Team
Site.
• Select Collaboration tab > Team Site template.

16. On the SharePoint Admin Services screen, if applicable, enter the details of an account that has
administrative rights on your SharePoint server. Ensure you enter the correct port for the SharePoint
Administration site. This port can be determined by launching SharePoint Central Administration on
the SharePoint server and looking at the port number in the URL.
17. On the Marketing HQ properties screen, enter the currency symbol you wish to use to present financial data in the Portrait HQ marketing dashboard.
18. On the Interaction Optimizer Properties screen, check Enable Interaction Optimizer Integration
if Interaction Optimizer is one of the products you are installing. If not, uncheck this option.
•

If you checked this option, provide the URL of the web site hosting the IO web service. Accept
the default if IO is installed on the same server as Portrait Shared Server.
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19. On the Report Server properties screen, check the Add link to report portal in HQ box if you want
to add a link to the Interaction Optimizer reports to the HQ. You must replace localhost in the Report
Manager URL with the name of your Report Server (even if the Report Server is collocated with
Portrait Shared Server).
20. On the Report Server Data Source Properties screen, if application, enter the name of the database
server where the Portrait Data Warehouse database resides. Enter the name of the Portrait Data
Warehouse database. Enter the details of a SQL Server login that has at least Connect, Select and
Execute permissions on the Portrait Data Warehouse database.
21. On the Ready to Install the Program screen, click Install.
22. Click Finish.

Installing DWH SSIS packages
The campaign monitoring features of Portrait HQ rely on historical and aggregated data from the Portrait
Data Warehouse database (named PortraitDW by default). This data warehouse database is populated
and updated by SSIS packages that need to be installed on to a database server that has SQL Server
Integration Services.
If you are installing Interaction Optimizer or Portrait Dialogue, follow this procedure:
1. Log on to your database server and run the setup.exe file located in \Portrait Shared
Server\SSIS Packages\ on your installation media. Right-click the setup.exe file and select
Run as Administrator.
2. Accept the default installation folder and click Next.
3. On the first Database Server screen, provide the connection details for the PSR database. (The
default PSR database catalog name is PortraitPSR.)
4. On the second Database server screen, provide the connection details for the PDW database. (The
default PDW database catalog name is PortraitDW.)
5. On the next screen, check Enable IO integration if you are installing Interaction Optimizer . Check
Enable Dialogue Integration if you are installing Portrait Dialogue.
6. On the Database Server screen(s), provide the connection details for the IO database (if installing
Interaction Optimizer) and then the PD database (if installing Portrait Dialogue).
7. Click Install to install the DW Populate SSIS package. This package gets installed as DWPopulate.dtsconfig in the Portrait Shared Server install folder, for example, C:\Program Files
(x86)\PST\Portrait Shared Server\SSIS).
Note: Interaction Optimizer users can optionally tune the DWPopulate package by changing configurable settings that are held in the DWPopulate.dtsconfig file. The relevant settings are:
• The minimum number of rows that remain in the source IO staging tables. This is a system
tuning parameter and should not be changed from the default value unless recommended
by the Portrait support team.
\Package.Variables[User::IO_MinSourceHistoryRows].Properties[Value]
• The size of the batches of records copied from the source IO staging tables. This is a system
tuning parameter and should not be changed from the default value unless recommended
by the Portrait support team.

30

Portrait Suite 1.0

Chapter 6: Installing Portrait Shared Server
• \Package.Variables[User::IO_BatchCopySize].Properties[Value]
The correct tuning of these values can reduce the locks being taken out on the staging tables
during data transfer and therefore reduce the performance impact of DWPopulate on the IO
runtime.

Scheduling data warehouse updates
The SSIS packages used to update the data warehouse must be scheduled to run at regular intervals
to ensure that the data warehouse is kept up to date. To use SQL Agent to schedule data warehouse
updates, follow this procedure:
1. Create a new SQL Agent job from SQL Server Management Studio. Right-click SQL Server Agent
and select New Job.... Specify a name and description for the new job and then select Steps.
2. Add a new job step by clicking the New... button on the steps page.
3. Provide a name for the job step and specify its type as SQL Server Integration Services Package.
The package source should be set to File System and the Controller.dtsx package should be selected by browsing to the location that the SSIS packages were installed.
4. Specify the configuration file in the Configuration tab by clicking on Add, browsing to the location
of where SSIS packages are installed and selecting the DWPopulate.dtsConfig file.
5. Click the OK button to add the new job step.
6. Select the Schedules page in the new job wizard and click the New... button to add a schedule for
the job.
7. It is recommended that the DW population process is run once every hour. Select the Schedule
Type of Recurring and ensure the schedule is enabled. The frequency of the schedule should be
Daily and should be set to occur every hour starting at midnight and ending at 23:59. Click OK twice
to complete the schedule definition and new job.

Setting up HQ users
Setting up HQ users varies depending on which Portrait Suite applications you are installing.
• If Portrait Dialogue is one of the applications you are installing, then you should follow the procedure
Configuring a Portrait HQ user's type in the Portrait Dialogue Reference Guide.
• If Portrait Dialogue is not one of the applications you are installing, then you should follow the procedure
Managing HQ Users in either the Portrait Explorer Administration Guide or Interaction Optimizer Administration Guide.

Purging old and deleted data from the database
Deleting an item from Portrait HQ removes the item from view but does not remove the data from the
database. Purging deleted items from the system is achieved via stored procedures which exist in the
PSR and Data warehouse databases.
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Removing deleted entries from the PSR database
Use the stored procedure PurgeDeletedEntities to set up automatic purging of deleted entries from
the PSR database.
Note: By default this procedure will only remove data that has been marked as deleted for more than
14 days.
1. To schedule this to run automatically, create a new SQL Agent job in SQL Server Management
Studio.

2. In the job Steps page, create a new job step. Give the job step a name, select the Transact-SQL
script (T-SQL) Type and set the Database to be your PSR database. Set the Command to be: EXEC
PurgeDeletedEntities.
• The PurgeDeletedEntities stored procedures has three optional parameters:
• parameter 1 is the number of rows purge in a single batch. Default 1000.
• parameter 2 is the maxumum number of batches to purge. Default is -1, which means that all
data that can be purged is deleted.
• parameter 3 is the number of days data must be marked for deletion, before the purge job deletes
the data. Default = 14.

32

Portrait Suite 1.0

Chapter 6: Installing Portrait Shared Server

3. On the Schedules page, set up an appropriate schedule to clear data regularly - Daily is recommended.
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4. When complete, the job will appear in SQL agent jobs list, for example, Purge PSR Data.

Removing old history from the Data Warehouse database
Use the stored procedure PurgeDWHistory to set up automatic purging of old history data from the
Portrait Data Warehouse (PDW) database. This includes purging old request, treatment, behaviour and
response logs.
Note: This procedure will remove data that is older than 90 days (by default) but only one month at a
time starting from the oldest treatment date.
1. To schedule this to run automatically, create a new SQL Agent job.

2. In the job Steps section, execute the procedure PurgeDWHistory against your PDW database.
This procedure optionally takes an integer denoting number of days as a parameter – all history recorded prior to these number of days is removed.
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3. Set up an appropriate schedule to clear out data regularly - Daily is recommended so that the affected
number of rows remains limited and do not cause table locks to be acquired on the affected tables.
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4. When complete, the job will appear in SQL agent jobs list, for example, Purge DW History Data.
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Installation overview

Installation overview
To install Portrait Dialogue, complete the procedures listed below.
Note: These procedures guide you through setting up Portrait Dialogue with one database and instance.
The steps should be repeated for each additional database.
Installation procedure

Time estimate

Installing the Portrait Dialogue database on page 39

30m

Verifying the database installation on page 40

30m

Installing the Dialogue Server on page 41

30m

Installing the Portrait Dialogue License on page 41

30m

Installing Dialogue Web Applications on page 41

30m

Verifying the web solution installation on page 42

30m

Configuring authentication type on page 43

30m

Configuring the Dialogue Server API URL on page 44

30m

Configuring the Dialogue Server API on page 44

30m

Before you begin
Before you begin your installation, take note of the following information:
• The Portrait Dialogue installation involves installing a number of key components that can be installed
on separate or multiple servers.
• Database Server <--> Application Server:
• Special server setup is required if the database server and application server reside on different
domains or have firewalls between them. Please read the document MTS and DCOM setup.doc,
which is available on the installation media (ZIP/DVD/ISO).
• Web Server <--> Application Server
• Web applications use SOAP to communicate with the web services on the application server. Port
80 is used by default. Communication port can be changed in the web.config file for each web
application.
• For the Dialogue database install, ensure you have:
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• Created the Portrait Dialogue database and a database user with full access to the database (in
SQL Server or the Oracle database)
• Tested the database connectivity between the application server and the database server.
Note: We recommend running the installation from the application server. If for any reason this is
not possible, you can run it directly on the database server, but this will require manual creation of the instance, and sharing of root directory on the application server after installing
the Portrait Dialogue server.

• Uninstall any other instances of Dialogue Server that have been installed on the server. Note: You
can only run one Dialogue Server per application server - the Dialogue Server runs as a COM+
package and 3 Windows services.
• Create a user account (local or domain) with local administrator rights to use as the Dialogue Server
service account.
• Log on to the application server with a user that has administrative rights.
• For the Portrait Dialogue Web Applications install, ensure you:
• Know the URL to the Dialogue Server API (Web services used by the Web Applications)
• Have set up a new IIS web site or have the name of an existing site to use.
Note: • If you want to use Windows authentication in Portrait Dialogue, you must use a domain user
account as the Dialogue Server service user account.
• The Dialogue Server runs as a 32-bit application on either 32 or 64-bit operating systems.
• All server names should be no longer than 15 characters, or even shorter for languages that
require more than one byte storage for each character. Please see http://technet.microsoft.
com/en-us/library/cc731383.aspx for more information.

Installation procedures
Installing the Portrait Dialogue database
1. To start the installation, double-click InstallMenu.exe which can be found in the root directory of the
Portrait Dialogue installation media (DVD/zip files).
2. Click Setup Dialogue Database. The Welcome screen appears.
3. Click Next to continue. The Destination Folder screen appears.
4. Select the installation folder (or accept the default location) and then click Next to continue. The
Database Type screen appears.
5. Select the database server type you are installing Portrait Dialogue to and then click Next. The
Database Server screen appears.
6. Choose the database server (Server name for SQL Server or TNS alias for Oracle).
7. Enter the username and password. (Windows authentication only supported on SQL Server).
8. Enter (or browse for) the name of database (only applies to SQL Server).
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9. If you cannot browse the database catalog, your user credentials may be incorrect. Click Next to
continue, the Instance Name screen appears.
Note: The information entered here is used as the connection settings for the Instance you define
later in the setup. The instance connection string can be altered later using the Dialogue
Admin tool.
10. Enter the instance name for your installation, for example:
• PROD (for production
• TEST (for testing)
• DEV (for development)
The name cannot contain any special characters (like $ %) or space (blanks).
11. Enter a short identifier (ISID) for your new instance. The short identifier must consist of one or two
uppercase alphabetic characters.
12. Click Next to continue. The Customer ID Datatype screen appears.
13. Choose the datatype to use for the Customer ID field, and then click Next.
Note: Examine the customer data you are going to use with Portrait Dialogue. To get optimal performance we recommend using the same datatype for the Customer ID that you have in your
customer database. Note: If you are going to use varchar as your customer id datatype,
the collation of the Dialogue Server database and the customer ID column in your customer
database must be the same. This setting is global for the current instance. It can be changed
later using SQL scripts provided on the install CD (SQL Server Only). Note: No script is
available for Oracle, and there is only support for four data types:
•
•
•
•

String (varchar2(40))
Unicode string (nvarchar2(40))
Numeric (number(31, 0))
Integer (integer)

14. On the Template Folder screen, select the root folder for templates and file storage for this instance.
Check the Share checkbox to share the folder as MH, and then click Next to continue.
Note: If you chose to alter the default path, make sure you take the Instance name into consideration
in the path if running multiple instances.
15. Click Install.

Verifying the database installation
1. Open SQL Server Management Studio and log on to the server using the same credentials you
specified during the install.
2. Check that the Portrait Dialogue tables are populated in the database.
3. Open a new query window and execute the following query:
select * from SYSTEM_INFO.
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4. Verify that you get the correct version returned in the SI_DATABASE_VERSION field.
Note: All system SQL queries in Portrait Dialogue are written without database and user prefix i.e. select
* from db.dbo.mytable is written select * from mytable. So your user account used in the connection
string must be set up to support this.

Installing the Dialogue Server
1. To start the installation, double-click InstallMenu.exe which can be found in the root directory of the
Portrait Dialogue installation media (DVD/zip files).
2. Click the Install Dialogue Server. The Welcome screen appears,
3. Click Next button to continue. The Destination Folder screen appears.
4. Select the Portrait Dialogue Server installation directory (or accept the defqault option). Click Next
to continue. The Setup Type screen appears.
5. Select the installation type and click Next. The Logon Information screen appears.
6. Enter the credentials for the user account that the Dialogue Server processes will run under. This is
the Dialogue Server service user account. The username must be in the form: <domain>\<username> or <machine name>\username.
You can also create an account using the “New user Information” during setup.
Note: The installation will verify the credentials you enter. If for some reason this verification fails,
you will get an error message. You may ignore this and continue if you are sure the credentials
are right.
7. Click Next to continue.
8. Click Install.

Installing the Portrait Dialogue License
After you have installed the server, you need to copy a Portrait Dialogue license file into the folder where
the server was installed This file is provided by Portrait Bowes Software or one of its distributors. Restart
the Dialog Server COM+ application (using Component Services) after the file has been installed.
The default folder for the license file is: <portrait dialogue root directory\Dialogue
Server

Installing Dialogue Web Applications
1. To start the installation, double-click on InstallMenu.exe, which can be found in the root directory
of the Portrait Dialogue installation media (DVD/zip files).
2. Click on Install Web Solutions The Welcome screen appears.
3. Click on Next. The Destination Folder screen appears.
4. Choose an installation folder or accept the default option. One folder is created for each of the web
applications. The folders will be web shared.
5. Click on Next. The Setup Type screen appears.
6. Choose to install all web applications (Complete) or a subset (Custom). Click on Next to continue.
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7. Overview of the different web applications:
• Dialog Server API—Web service API for the Dialogue Server. Must be installed on the application
server where the Dialogue Server is running.
• Customer View—Customer View normally installed on the internal web server.
• Customer Web Access—Hosting applications for questionnaire surveys and viewing email on
web. Normally installed on the public web server.
• Telemarketing Web—Telemarketing application normally installed on the internal web server.
• Report Portal—Report Portal application normally installed on the internal web server. Must be
installed to use integrated reporting in Visual Dialogue.
• Report Viewer—Report Viewer application used to provide simple access to internal and external
users for viewing reports. Normally installed internally, optionally installed on the public server.
• Questionnaire Preview—used by Visual Dialogue to test and preview questionnaires. Must be
installed for questionnaires to work in Visual Dialogue.
• Dashboard—Support for this web application is deprecated from version 5.2 onwards. Dashboard
will not be installed by default during a “Complete” installation. You will need to perform a “Custom”
installation and select this component for it to be installed. Access rights for Dashboard users will
need to be explicitly set in Dialog Admin.
• Emarketing—HTML email designer normally installed internally. Must be installed for Message
Designer templates to work in Visual Dialogue.
• Web Utilities—Hosting applications email, link, response tracking, and published files on web.
Normally installed on the public web server.

8.
9.
10.
11.
12.

13.
14.
15.
16.

Choose the web site to install the web application to. Make sure you enter the correct name: no
verification is done. If you enter an incorrect website name, the installation will fail later. The name
of the site configured on the server is shown in the IIS manager.
Check Only copy files to copy the files to the install directory without creating web shares. This is
useful if you want to do the web sharing manually.
Check Enable Windows Authentication to configure the internal web applications to use Windows
authentication.
Override default web share names for the different web applications (if required).
Override default web share names for the different web applications (if required).
Some of the applications require write access to a subfolder (for logging, caching, etc.) to work. To
automatically set this permissions check this option. This will give the “everyone” user group-write
access. You can alter this later to strengthen security.
Enter the name of your company. This information is used by the Message DEsigner application.
Enter error logging options for the Message Designer application.
Enter the URL to the Dialogue Server API and the system administrator email address and phone
number.
Click on Install.

Verifying the web solution installation
The first thing to check is the MHDialogServerAPI (web services) application.
Check that you can access the web service overview page by entering the URL to the MHDialogServerAPI
in a browser from all servers you installed any web application to.
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Example URL: http://vmdev-test01/MHDialogServerAPI/APIOverviewPage.aspx
Further testing of the different web applications needs to be done when you have configured the first
domain on your new instance.

Configuring authentication type
Customer View, Telemarketing, Report Portal, Web Portal, and Dashboard support two different authentication mechanisms:
Forms authentication

This is the default authentication type. The user logs in using a web-based
login page.

Mixed authentication

In this case, the user is first authenticated using Windows authentication.
If this is successful, the user is automatically logged in. Otherwise, the
user is redirected to the forms authentication page.

If you want to change the authentication type that you chose during installation, you must do this
manually as described in Changing authentication type in web.config on page 43.
If you are using forms authentication, no special IIS configuration is needed. If you want to use mixed
authentication, you need to configure IIS specially. This is done slightly differently for IIS 6 and IIS 7.
IIS 7 configuration for mixed authentication
1. Open the MHDialogServerAPI web share in IIS Manager, and switch to Content View.
2. Right click on WindowsAuthenticationAPIService.asmx and switch to features view. Locate and
double-click on the Authentication option in the right-hand pane. Ensure that only Windows authentication and ASP.NET impersonation are enabled.
3. The WinLogin/WinLogin.aspx page in Customer View, Telemarketing, Report Portal, and Dashboard
must only allow Windows authentication and ASP.NET impersonation. Select the WinLogin\WinLogin.aspx page in IIS, and switch to features view. Locate and double-click on the Authentication
option in the right-hand pane. Ensure that only Windows authentication and ASP.NET impersonation
are enabled.
Changing authentication type in web.config
• For forms authentication:
• The forms element must have the attribute loginUrl="Login.aspx".
• The following element must be present in the appSettings section:
<add key="AuthenticationType" value="Forms"/>
• For mixed authentication:
• The forms element must have the attribute loginUrl="WinLogin/WinLogin.aspx".
• The following element must be present in the appSettings section:
<add key="AuthenticationType" value="Mixed"/>
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Configuring the Dialogue Server API URL
All Web Applications have a configuration file specifying the URL to the Dialogue Server API. If setting
up a web application manually (not using the installation program), then you have to specify this URL
manually.
Steps the set the Dialogue Server API URL manually:
1. Open the web application’s Config\MH.DataAccessLayer.config file.
2. Change the serviceBaseLocation attribute in the XML's root element to the Dialogue Server API URL
you use.

Configuring the Dialogue Server API
The Dialogue Server API can be configured for operation in two different modes: COM Server mode and
API Proxy mode.
COM Server mode
The COM Server mode is the default setting. In this mode the Dialogue Server API communicates with
the Dialogue Server’s COM components. The Dialogue Server API is normally set up with this configuration.
API Proxy mode
Using the API Proxy mode, the Dialogue Server API acts as a proxy-server, passing all requests through
to another installation of the Dialogue Server API server.
To enable this mode, set the UseWebServices value in web.config to true. The address of the Dialogue
Server API must also be set:
<addkey="UseWebServices"value="true"/>
<addkey="WebServiceURL"value="http://server/MHDialogServerAPI"/>
Configuring access to web services and methods
It is possible to enable and disable the different web services in the Dialogue Server API. Individual
methods inside a web service can also be enabled or disabled. All web services and methods are by
default enabled.
These settings are defined in an xml config file named APIAccess.config.
Configuring access to instances
It is possible to enable and disable access to different Portrait Dialogue instances through the Dialogue
Server API.
These settings are defined in the xml config file named InstanceAccess.config

Installing Portrait Dialogue client software
Installing the Portrait Dialogue client software includes installing two key components:
• Visual Dialogue
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• Dialogue Admin
Note: If you want to run an unattended installation, see Running an unattended installation in the Appendix.
1. To start the installation, run the InstallMenu.exe found on the Portrait Dialogue media.
2. Click Install Visual Dialogue. The Welcome dialog box will appear, click Next to continue.
3. Choose the destination folder for the program files. Click Next to continue.
4. Choose to install Visual Dialogue, Dialogue Admin and samples (Complete), or only selected
components (Custom). Click Next to continue.
5. Enter the name of the Dialogue Server to connect to and the instance name. If you do not know the
instance name enter default. Click Next to continue.
6. Click Install to start the installation.

Verifying the installation
1. Click on the Visual Dialogue shortcut to start Visual Dialogue for the first time.
Note: The installation creates shortcuts to the Visual Dialogue on your desktop. Shortcuts are also
available under Start > Program Files > PST > Portrait Dialogue
2. Log in to Visual Dialogue.
• If using Portrait Dialogue authentication, enter your Portrait Dialogue username and password,
and click OK.
• If using Windows authentication, check the box Use Windows Authentication, and click OK.
Note: You can click on the Advanced button and update the Dialogue Server Host and Instance
name if your server details have changed.

3. If everything is set up correctly and your username has the necessary user rights, Visual Dialogue
will start. If you have problems accessing the Dialogue Server, typical error messages include:
Error message

Description

Error occurred when trying to con- This error typically occurs if your computer is not able
nect to 'MHDialogServer.MHSystem- to communicate using COM+ and RPC to the Dialogue
API@DIALOGSERVER' : The RPC server Server. Check the following:
is unavailable.
• That the Dialogue Server Host name is correct
• That there are no firewalls preventing your computer
communicating using COM+ and RPC with the Dialogue Server Host server.
Error occurred when trying to connect to 'MHDialogServer.MHSystemAPI@DIALOGSERVER' : Access is
denied.
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windows user account is not allowed access to the
Dialogue Server COM+ components. Check the following:
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Error message

Description
• That your user account is allowed “Distributed COM
Access” to the Dialogue Server. Contact your network administrator to verify this.
• The Dialogue Server has a local group called “Distributed COM Users” make sure that your windows
account is added to this group directly or via other
domain group’s memberships.

Important: If your computer is not on the same domain as the Dialogue Server, you will require a
number of additional steps to connect to the Dialogue Server. Contact your Domain or
Network Administrators and send them the MTS and DCOM setup.pdf document provided
on the installation media (zip/dvd/iso).

Configuring the Dialogue Admin instance
If you install the Dialogue Admin client, you need to add the Dialogue Server to the Dialogue Server
Hosts node.
To add the Dialogue Server:
1.
2.
3.
4.

Open the Dialogue Admin window:
Right-click on Dialogue Server Hosts and select New.
Type in the computer name of the Dialogue Server.
Click OK.

Note: To delete an invalid host in the Dialogue Admin window, select the Dialogue Server Hosts
node, then select the host in the right view and click Delete.
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Installation overview

Installation overview
To install Portrait Interaction Optimizer, complete the procedures listed below.
Installation procedure

Time estimate

Installing Portrait Foundation components on page 48

10m

Installing Interaction Optimizer (IO) on page 51

10m

Creating a new repository on page 52

10m

Importing configuration into repository on page 52

10m

Deploying the configuration on page 53

10m

Installing the WCF web services on page 53

10m

Installing Simulation SSIS packages on page 56

10m

Before you begin
Before starting the installation, ensure you:
• If you want to do a clean install, ensure you uninstall any pre-existing versions of Interaction Optimizer
and its sub-components (Portrait Foundation and Portrait Shared Server).
• Have the credentials of a SQL Server login that has administrative privileges on your SQL Server.
• Source all required software and associated documentation.

Installation procedures
Installing Portrait Foundation components
Creating a new IO database
Use the following procedure to create a new Interaction Optimizer database. This procedure uses the
Foundation software database installer.
1. Log on to the Interaction Optimizer Application Server using a designated Windows account that has
rights to administer the SQL Server.
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2. Run the FdnDbSetup.exe that can be found on the Interaction Optimizer release media in
\Foundation Media\Software\Installsets\Database\. Ensure you right-click the .exe
file and select Run as Administrator.
3. Click Next and select Create new database.
4. Click Next and type the Database Server (and possibly instance) you want to connect to.
5. Type the Database name you want to create.
Note: Take note of the IO database name because you will refer to it during the SSIS installation.
6. Ensure Use Windows Authentication check-box is selected.
7. Click Next and check that the Server collation is set to Latin1_General_CI_AS.
Note: If the Description shown for the Server collation displays ‘Case-sensitive collations cannot
be used’, then you can proceed with the installation by selecting User defined collation and
choosing Latin1_General_CI_AS from the drop-down.
8. Click Next and confirm the database datafile location.
Note: Ensure the datafile location specified matches the default datafile location of your SQL
Server machine.
9. Click Next and select whether you are completing a production or non-production install.
10. Click Next and select Custom - unencrypted stored procedures or additional scripts. Uncheck
Enable DataMart functionality.
11. Click Next. Leave the Unencrypt stored procedures and Code fields blank.
12. Click Next. On the Select Database Scripts dialog, leave the Execute Implementation Scripts
checkbox selected and browse to Installation\Foundation Database
Scripts\cre_imp_db.txt on the Interaction Optimizer installation media.
13. Click Next and enter a description to describe the version of Interaction Optimizer you are installing,
for example, InteractionOptimizer54.
14. Click Next to start the database creation process.
15. Click Close.
16. To verify the installation:
a.
b.
c.
d.
e.
f.

Log on to a machine with SQL Server and start SQL Server Management Studio.
In the Server Type field select Database Engine.
In the Server Name field select the appropriate SQL server.
Ensure Windows Authentication is selected and click Connect.
In the Object Explorer window, check for the database name you specified above.
Expand the database and look for a table called io_application_params.

g. If both the database and table exist then the installation has been successful.

Installing Portrait Foundation
Use the following procedure to install Portrait Foundation's IO recommendation engine that decides
which suggestions to make.
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Installing Portrait Foundation components
Note: This procedure requires Portrait Foundation software which can be found on the Interaction
Optimizer media (zip file/DVD) in \Foundation Media\Software\Installsets\Core_Software\.
1. Right-click the setup.exe in \Foundation Media\Software\Installsets\Core_Software\
and select Run as Administrator. Click Next.
2. Accept the default Destination Folder and click Next.
3. On the Portrait Foundation Installation Type screen, select Custom and click Next.
4. On the Custom install screen, select the components as highlighted below:

5. Click Install.
6. Once the installation is complete, ensure the Launch Portrait Foundation System Setup checkbox
is selected and click Finish.
7. On the Portrait System Setup screen:
a. Enter a name for the Portrait Foundation system. If you are installing a single Portrait Foundation
system, then you can accept the default of MyPortrait.
b. Enter the Domain name, User name and Password credentials that will be used to access the
Portrait Foundation services for the system.
c. Click Next.
8. On the Operational database screen:
a. Type the name of the database server where the Interaction Optimizer database is installed
(identified in procedure: Creating a new IO database on page 48).
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b. Type the name of the Interaction Optimizer database created in Creating a new IO database
on page 48.
c. Ensure Use Windows authentication is selected.
d. Click Next.
9. On the Transient database screen, ensure all four options are left unchecked and click Next.
10. On the Clone process server screen, leave the Clone process server field unchecked and click
Apply to complete the configuration.
11. Click Start in the System Setup Launchpad to apply the configuration changes. Close the System
Setup Launchpad when changes have been successfully applied.
12. Click Close to exit the configuration.

Installing Interaction Optimizer (IO)
1. On your application server, run the setup.exe (right-click and select Run as Administrator) located
in the Installation folder on the Interaction Optimizer installation media (.iso).
2.
3.
4.
5.
6.

Select your language and click OK.
Click Next on the Welcome dialog.
Accept the license terms and conditions and click Next.
On the Setup Type screen, select Complete and click Next.
On the Database Server screen, provide the connection details for the existing PSR database and
click Next. (The default PSR database catalog name is PortraitPSR.)
7. On the next Database Server screen, provide the connection details for the existing Portrait Data
Warehouse (PDW) database and click Next. (The default PDW database catalog name is PortraitDW.)
8. Click Install.
Note: This installation assumes you have installed Portrait Foundation's core software using the default
system name of MyPortrait. If you have used a different system name, then rename the MyPortrait folder (in c:\program files\pst\portrait io\systems) to match the system
name you chose.
Note: If you are installing more than one instance of Interaction Optimizer onto a single physical server,
then you must create a folder beneath c:\program files\pst\portrait io\systems
for each additional tenant. To do this:
1. Copy the existing folder beneath c:\program files\pst\portrait io\systems to
the same location
2. Give the copied folder the system name of the tenant you are adding
3. Modify the content of the Portrait.IO.DataAccess.config to contain the database
connection details of the Portrait Shared Repository and Portrait Data Warehouse that you
are using for this tenant.
If you are installing Interaction Optimizer on more than one server, ensure you repeat these steps
for each application server.
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Creating a new repository
1. Create a Config directory beneath the Interaction Optimizer installation directory on your local machine, for example:
c:\program files(x86)\pst\portrait io\Config
2. In this folder, create two directories called Master and Snapshot:
c:\program files(x86)\pst\portrait io\Config\Master
c:\program files(x86)\pst\portrait io\Config\Snapshot
3. Start the Repository Manager application.
Because this is the first time the application has been run, the Repository Manager displays the Repository properties dialog box. Click Cancel to close the dialog box and ignore any warnings.
4. Enter the new repository properties:
• Click Repository-New repository to display the New repository dialog box.
• Click Browse to display the Repository properties dialog box, ignore any warnings. In the Source
control provider field, select Portrait Snapshots. In the Master and Snapshot fields, click
Browse and locate the Master and Snapshot folders that you created on your local machine.
• Click OK to close the dialog box.
• In the New repository dialog box, enter an owner, administrator user name and password. For
example using the details:
Owner : IO
Administrator user name : Superuser
Administrator password : Password
5. Click OK to close the dialog box.
6. Close the Repository Manager. Click Yes to creating the repository now.

Importing configuration into repository
1. Start the Repository Manager application.
2. Click Repository and log on to the repository using the credentials you provided when creating the
new repository.
3. Click Repository-Import and choose Portrait_Platform.cab in the Repository folder on the Portrait
Foundation installation media. Wait for the import packages to be completed and click OK.
4. Click Repository-Import and choose Portrait_IO.cab in the C:\Program
Files(x86)\PST\Portrait IO\IORepositoryPackage folder on your local machine. Wait
for the import packages to be completed and click OK.
5. Click Repository-Import and choose Portrait_IO_Demo.cab in the C:\Program
Files(x86)\PST\Portrait IO\IORepositoryPackage folder on your local machine. Wait
for the import packages to be completed and click OK.
6. Close the Repository Manager.
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Deploying the configuration
1. Start the Configuration Suite application.
2. Log on to the repository using Portrait authentication. Make sure that you are logging in to the correct
repository by checking the top panel of the dialog box. If not, click Settings and choose the correct
repository.
3. Click File > Open and select the Interaction Optimizer workspace, then click OK.
4. Click View > Deployer and wait till the deployable nodes get loaded
5. Click View > Settings and ensure that the availability state is set to Published.
6. Click the Deploy button to start the Portrait deployment wizard.
7. Follow the instructions, clicking Next to proceed through the steps. If you want to specify an optional
release name, ensure that the name does not contain any "dot" characters.
8. When you reach the end of the wizard, click Finish to start the deployment.
9. When the deployment is complete, click Yes to activate the deployment.

Installing the WCF web services
Interaction Optimizer provides a set of Windows Communication Foundation web services.
Web service

Description

Interaction Optimizer
web service

This service provides functionality for client applications to request IO suggestions and record responses to these suggestions.

Decisions web service

This service is for internal use and provides functionality to support integration
with other Portrait products.

IO Bridge web service

This service is for internal use and provides functionality to support integration
with other Portrait products.

To install these web services, repeat the following steps on each web server:
1. Browse to the folder C:\program files(x86)\pst\portrait io\IOWebServicesInstallation, right-click InstallIOWcfWebServices.exe.config and select Edit to open the file in
a text editor. Modify the following value attributes in relation to your installation setup:
• <add key="DbServer" value="MYHOST\MYINSTANCE" /> , specifying the host (and then
instance, if required) for the database server.
• <add key="Dbname" value="MYDATABASE" /> , specifying the name of the database
• <add key="VirtualDirUser" value="MYHOST\MYACCOUNT" />, specifying the Windows
account name to be used for the IIS virtual directory for the web service.
• <add key="VirtualDirPassword" value="XXXXX" />, specifying the password for that
Windows account.
2. If you have installed the Portrait Foundation core software in a location other than the default of
C:\Program Files(x86)\PST\Portrait Foundation, or your Portrait tenant system name
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is different from the default of MyPortrait, or if you are installing a multi-tenant system, then you
must also verify that the following value attributes are correct in relation to your installation setup:
• <add key="PortraitIoBaseDirectory" value="C:\Program Files\PST\Portrait"
/>, specifying the Portrait Foundation core software installation location.
• <add key="SystemName" value="MyPortrait" />, specifying the name of the Portrait
Foundation system tenant.
3. For DbLoginMode, leave the value unchanged as Windows , if your Windows account has read
permission on the database.
• If not (if, for example, your Windows account does not have access to the database server, or if
your database and web-tier machines are on different Windows network domains), then replace
Windows with SQL , and replace SQL _ USERNAME and SQL _ PASSWORD with a SQL Server
user account and password.
4. Save the changes and close the file.
5. Right-click the InstallIoWcfWebServices.exe and select Run as Administrator. Note: All
settings inside the <appSettings> tag in the configuration file can be overridden by passing the key
name preceded by “/” and its value as arguments when calling InstallIoWcfWebServices.exe
program. Example:
InstallIoWcfWebServices.exe /VirtualDirUser domain\user /VirtualDirPassword
password /IisWwwRoot C:\Inetpub\MyWwwRoot\ /OnlyDeleteDirectories true
• Optionally, all the settings in the <appSettings> tag in the InstallIoWcfWebServices.exe.config configuration file can be copied into a separate file called InstallIoWcfWebServices.config.xml to preserve settings and prevent it from being overwritten when
doing an upgrade or re-installation. This new file can be created in the same directory as InstallIoWcfWebServices.exe.config with the following sample content.
<?xml version="1.0" encoding="utf-8" ?>
<appSettings>
<add key="UICulture" value="en-US"/>
<add key="WebConfigFileName" value="Web.Config"/>
<add key="BackupWebConfigFileName" value="Web.Config.original"/>
<add key="PortraitIoBaseDirectory" value=".\..\"/>
<add key="IoWebServicesInstallationRoot" value=".\"/>
<add key="ServiceMakerProgramPath" value=".\..\..\Portrait Foundation\WebServices\ServiceMaker\bin\ServiceMaker.exe"/>
<add key="IisWwwRoot" value="C:\Inetpub\wwwroot\"/>
<add key="SystemName" value="MyPortrait"/>
<add key="VirtualDirUser" value=""/>
<add key="VirtualDirPassword" value=""/>
<add key="DbServer" value="MYDBSERVER"/>
<add key="DbName" value="PortraitIO"/>
<add key="DbLoginMode" value="Windows"/>
<add key="DbUser" value=""/>
<add key="DbPassword" value=""/>
<add key="OnlyDeleteDirectories" value="false"/>
</appSettings>
Note: Settings placed in this alternative file precede those in InstallIoWcfWebServices.exe.config. The system, however, will use settings in InstallIoWcfWebSer-
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vices.exe.config for any items that are not found in InstallIoWcfWebServices.config.xml.

Review the WCF Interaction Optimizer web service properties
The WCF Interaction Optimizer web service virtual directory will inherit the existing website properties.
These should be reviewed to ensure they are as required. The following review steps should be repeated
for the WCF Decisions Web Service and the IO Bridge Web Service.
1. Click Start, Control Panel, Administrative Tools, Internet Information Services (IIS) Manager.
2. Select the IOWCFWebService virtual directory.
3. In the IOWCFWebService Home page, double-click on Authentication:
• Select Anonymous Authentication and click on Edit
• Verify the correct user details or modify if necessary and click on OK
• 64-bit system users only. Click on Application Pools and open Advanced Settings on the Default
Apppool. Ensure the web service is running in an application pool where Enable 32-bit applications is set to True.
Verify that the Interaction Optimizer web service works
Note: If a port other than 80 has been used, change the URL to http://server:port/IOWCFWebService/IOWebService.svc, where port represents the port number.
Enter the following URL into a web browser:
http://<server>/IOWCFWebService/IOWebService.svc
If the name of the IIS virtual directory has been specified as something other than the default of IOWCFWebService, then change the URL here accordingly.
If the Interaction Optimizer web service is working, the following page displays:

Repeat the previous web service verification steps for the Decisions and IO Bridge web services.
They can be browsed to at the following URLs: http://<server:port>/DecisionsWCFWebService/DecisionsWebService.svc http://<server:port>/IOBridgeWCFWebService/IOBridgeWebService.svc.
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Important: If you are installing a multi-tenant system, then you must repeat the previous step separately
for each tenant. Ensure that the database name (DBNAME), system tenant name (SYSTEMNAME), and IIS virtual directory location (VDIR) and name (VDIRNAME) are all set to unique
values for each tenant.
To keep track of what configuration is set up for each tenant, you should prepare the Install_WCF_IO_Web_Services.bat file separately for each case. Save the configuration
for each case in a separate file, such as Install_WCF_IO_Web_Services_MyTenantName.bat, then run each of these .bat files in turn, once they are all ready.
To make the installer perform just the deletion of web services:
• <add key="OnlyDeleteDirectories" value="true"/>, specifying this installer should be
just run to delete virtual directories
• If you want to re-install web services in a separate website, it is recommended to run this installer with
OnlyDeleteDirectories set to true and then install the web services again.

Installing Simulation SSIS packages
Interaction Optimizer is supplied with the following SQL Server Integration Services (SSIS) packages
that allow information to be transferred between live and test systems:
• Utilities – a support package for the other Interaction Optimizer SSIS packages. You should install
this package before any other SSIS package.
• PromoteCampaigns – used to transfer tested and approved campaigns from a test system to the live
system.
• Simulation – used to transfer a recorded events from the live system to the test system to provide a
sample group for simulation interactions.
Creating the SSIS folder structure
1. Create a subfolder called SSIS on your local machine, for example:
<iohome>\SSIS
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Within the SSIS folder, create the following subfolders:
PromoteCampaigns
Simulation
import
export
Utilities
2. Open the Installation folder on the Interaction Optimizer installation media/DVD and copy the
content of SSIS packages to a temporary folder on your local machine. For example, c:\temp:
<iohome>\SSIS

Installing the Utilities package
1. Open the SSISPackages\<SqlServerVersion>\Utilities folder (where <SqlServerVersion> is the appropriate sub-folder for your version of SQL Server) and remove the Read only attribute
from UtilityPackages.SSISDeploymentManifest.
2. Double-click UtilityPackages.SSISDeploymentManifest and click Next on the Package
Installation Wizard.
3. On the Deploy SSIS Packages page, select File system deployment and click Next
4. Select the <iohome>\SSIS\Utilities folder. Navigate through the pages of the wizard confirming
the information is correct, and click Finish to install the utilities package.
Installing the Simulation package
1. Open the SSISPackages\<SqlServerVersion>\Simulation folder (where
<SqlServerVersion> is the appropriate sub-folder for your version of SQL Server) and remove
the Read only attribute from SimulationImportExport.SSISDeploymentManifest.
2. Double-click SimulationImportExport.SSISDeploymentManifest and click Next on the
Package Installation Wizard
3. On the Deploy SSIS Packages page, select File system deployment and click Next.
4. Select the <iohome>\SSIS\Simulation folder and click Next.
5. On the Configure Packages, select ImportSimulationData.dtsConfig and make the following
changes to the package property values:
• Connections[SQL Connection]
Set the Data Source to the name of the database server, for example localhost\OFFICESERVERS, and the Initial Catalog to the IO database name, for example PortraitIO. The other
components of the string can be left as the default values.
• Variables[User:ImportDirectory]
Set the value to the absolute path of the previously-created import folder, for example <iohome>\SSIS\Simulation\import
• Variables[User:TableListFile]
Set the value to the absolute path of the SimulationTableList.xml file, for example <iohome>\SSIS\Simulation\SimulationTableList.xml.
• Variables[User:UtilsDirectory]
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Set the value to the absolute path of the Utilities package, for example <iohome>\SSIS\Utilities.
6. On the Configure Packages, select ExportSimulationData.dtsConfig and make the following
changes to the package property values:
• Connections[SQL Connection]
Set the Data Source to the name of the database server, for example localhost\OFFICESERVERS, and the Initial Catalog to the database name, for example io_database. The other
components of the string can be left as the default values.
• Variables[User:ExportDirectory]
Set the value to the absolute path of the previously-created export folder, for example <iohome>\SSIS\Simulation\export
• Variables[User:TableListFile]
Set the value to the absolute path of the SimulationTableList.xml file, for example <iohome>\SSIS\Simulation\SimulationTableList.xml.
• Variables[User:UtilsDirectory]
Set the value to the absolute path of the Utilities package, for example <iohome>\SSIS\Utilities.

Installing the PromoteCampaigns package
The PromoteCampaigns SQL Server Integration Service (SSIS) package allows you to move campaign
data between Interaction Optimizer environments. This is useful if you are testing campaigns in one
environment, and then want to automatically transfer those campaigns into a production environment.
PromoteCampaigns transfers campaigns by restoring a backup of the Portrait Shared Repository database
into the target environment.
The PromoteCampaigns installation procedure includes:
• Ensuring you have a database login with sufficient privileges
• Running the SSIS package deployment manifest on the SSIS server to deploy the package to the file
system of the SSIS server
• Providing the package configuration values.
Pre-requisite database configuration
Before using the PromoteCampaigns package, the target database must be set up with a login suitable
for running the promotion. This step can be skipped if it is intended that the package will be run using
an account that has sysadmin privileges.
A login should be created on the account that will be used to run the SSIS package. It will be this account
that will be specified in the connection string in the configuration file (if using SQL Server authentication)
or the Windows account that will be used to run the SSIS package if using Integrated Security.
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Note: The login MUST NOT be a user in the PSR database but should be an alias to dbo in the PSR
database. This can be accomplished by issuing the following SQL command:
ALTER AUTHORIZATION ON DATABASE::[PSR Database] TO [login]
replacing the names of the database and login as appropriate.
The login must be a user with the following roles in each of the specified databases:
Database

Role

Interaction Optimizer (Foundation)

db_datareader>
db_datawriter

Master

db_datareader

Finally, the login MUST be granted the following server permission using the following command (this
must be issued by a sysadmin type user).
GRANT CONTROL SERVER TO [<domain\login>]
Where [login] is the same login to be used when running the PromoteCampaigns package. For more
information, see Moving campaign data to a different IO system in the Interaction Optimizer Administration
Guide.
Installation
The PromoteCampaigns packages is a single SSIS package intended to be installed on the same
physical machine as the SQL server instance on which it is intended to operate.
1. Copy the SSISPackages\ <SqlServerVersion> \PromoteCampaigns folder (where
<SqlServerVersion> is the appropriate sub-folder for your version of SQL Server) to the target
server and remove the Read only attribute from: PromoteCampaigns.SSISDeploymentManifest
and PromoteCampaigns.dtsx.
2. Double-click PromoteCampaigns.SSISDeploymentManifest and click Next to open the Package
Installation Wizard.
3. On the Deploy SSIS Packages page, select File system deployment and click Next.
4. Select the <iohome>\SSIS\PromoteCampaigns folder and click Next .
5. Once the deployment of the package file is complete the user will then be asked to provide the configuration values for the package:
• Package.Connections[Interaction Optimizer].Properties[ConnectionString]
The value is used to specify the connection string for the Interaction Optimizer (Foundation database)
in the target environment. For example, if moving campaigns into a production environment, this value
must be the connection string for the production Interaction Optimizer database. This should specify
either Integrated Security (when using a Windows account to log into the database) or the Username
and Password of an appropriate SQL Server login (see pre-requisites)
• Package.Connections[PSR Server MasterDB].Properties[ConnectionString]
The connection string to the system database called 'master' on the database server of the target environment. This connection string MUST use the login created in the pre-requisite steps unless using
a sysadmin account to run the package.
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• Package.Variables[User::DboLoginName].Properties[Value]
The login name (without enclosing square braces) of the login account created in the prerequisite
steps.
• Package.Variables[User::PSR_Backup_File].Properties[Value]
The full path to the PSR database backup file that contains the campaigns that you wish to move to
the target environment.
• Package.Variables[User::PSR_Database_Name].Properties[Value]
The name of the PSR database in the target environment.
• Package.Variables[User::PSS_Use_Windows_Auth].Properties[Value]
A flag to indicate whether we are using Windows users to log on to the HQ. If set to 'True', the Windows
user running the PromoteCampaign package MUST be able to log on to the HQ in the target environment. If 'False' both the PSS_Username and PSS_Password configuration values must be supplied.
• Package.Variables[User::PSS_Username].Properties[Value]
The name of an HQ user that can log on to the HQ in the target environment. Only required if not using
Windows authentication to log on to the HQ.
• Package.Variables[User::PSS_Password].Properties[Value]
The password of an HQ user that can log on to the HQ in the target environment. Only required if not
using Windows authentication to log on to the HQ.
• Package.Variables[User::PSS_WebService_URL_Stem].Properties[Value]
The URL of the PSS web services in the target environment, for example, http://MyPSSServer/PortraitSharedServices
Note: If PSS web service in the target environment is exposed only over SSL than we need to configure the appropriate certificate in client machine and use the secured url, for example https://MyPSSServer/PortraitSharedServices
Note: The package configuration values can be changed after the installation, by editing the file
<iohome>\SSIS\PromoteCampaigns\PromoteCampaigns.dtsConfig.
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Installation overview

Installation overview
To install Portrait Explorer, complete the procedures listed below.
Note: Portrait Explorer requires two key installation components, the Portrait Shared Server (PSS) and
Portrait Analytics Web Services (PAWS). If you have followed the install order of this guide, you
should have already installed the Portrait Shared Server.
Installation procedure

Time estimate

Installing Portrait Analytics Web Services on page 63

30m

Starting Portrait Analytics Web Services (PAWS) on page 64

30m

Before you begin
Before starting the installation, you need to:
• Ensure you have administrative privileges for all installs including login credentials to your SQL Server
machine.
• During the install, you will be prompted to enter Windows user accounts (username and password)
for running the PSS application pool and the connection to the PSR database from PSS/PAWS. It is
recommended that you use the same Windows account to manage all three components. The account
should:
• be on a network domain rather than a local machine
• have db_datareader and db_datawriter role permissions on the PortraitPSR database
• Source all required software and associated documentation, including:
Software + documentation

Media location (ZIP file/DVD)

Portrait Shared Server

Portrait Explorer media in: \Portrait Shared Server\

Portrait Analytics Web Services

Portrait Explorer media in: \PAWS\

Portrait Explorer Installation Guide (this Portrait Explorer media in: \Documentation\
guide)
PAWS license file

Contact Portrait Software Support.
Note: If you do not have a PAWS license file at installation,
you can create an empty license.xml and browse to the
location of this file during the PAWS installation. However,
you will not be able to start PAWS until you obtain the
proper license - which should then be copied to the PAWS
installation config folder.
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Software + documentation

Media location (ZIP file/DVD)
A license file has an expiration date and is specific to one
computer. If you change any of the IP addresses of the
computer, you may require a new license file.

Installation procedures
Installing Portrait Analytics Web Services
This task is accomplished using an InstallShield wizard, which guides you through a succession of pages.
You typically click on a Next button to move to the next page in a sequence (in which case you can always
use the Back button on the following page to return to where you were).
1. Run \PAWS\setup.exe from the Explorer installation media.
The PAWS InstallShield wizard opens at the welcome page. (Click on Next to move to the next page.)
2. Under License Agreement, review the license terms if necessary, and click on I accept the terms
in the license agreement.
You will not be able to proceed with the installation until you have accepted the license terms.
3. On the next page, select the install location. The default is c:\program files (x86)\PST\PAWS.
4. On the next page, locate the folder that contains your license.xml file, by browsing or typing in a
path.
Determine the location of your license file using Windows Explorer or otherwise, as the browser in
the wizard only shows folders.
5. Under Database User properties, enter the domain, name, and password for the Windows user
account that will be used by PAWS to access the Portrait Shared Repository database.
This is the same account that is used by Portrait Shared Server.
6. Under Database Server, supply details of the Portrait Shared Repository database.
a) Choose the database server, either by typing its name or by clicking on Browse... and choosing
it from a list.
b) If you are not currently logged in to Windows as a user with access to the server, choose Server
authentication using the Login ID and password below, and enter a login ID and password
for the server.
c) In the Name of database box, enter the database catalog to be used by PAWS, or click on
Browse... to choose the catalog from a list.
This is the same catalog that you specified for the Portrait Shared Repository during installation
of Portrait Shared Server (typically PortraitPSR).
7. Under Portrait Analytics Web Services, enter your choice of Web Services password (the same
password that you chose during installation of Portrait Shared Server).
Unless you have good reason to change them, you should accept the defaults for the number of
server instances and the port on which PAWS accepts connections.
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8. Under Tomcat Server, you can, if required, change Tomcat web server port details.
You should normally accept the defaults.
9. Under Setup Type, choose Complete.
There are currently no variations available in a custom installation.
10. Under Ready to Install the Program, click on Install.
During installation of the software, the Installing PAWS page shows a progress indicator.
11. On the final page, click on Finish to exit the wizard.
If Show the Windows Installer log was checked, a log file opens in Notepad.

Starting Portrait Analytics Web Services (PAWS)
1. In the Administrative Tools control panel in Windows, double-click on the Services shortcut.
The Services window opens.
2. Right-click on the line containing Portrait Analytics Web Services, and choose Start.
PAWS is now running as a Windows service.
Note: The installer configures PAWS to automatically start (with a delay, to allow SQL Server database
to start first) as a Windows service whenever the computer is restarted.
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Running the server installer
Before installing the Portrait Miner server:
• Make sure that your server machine is running a supported operating system — with all required operating system patches in place and any necessary changes made to the kernel parameters.
• Ensure you have a valid license file.
• Ensure that there is sufficient free disk space for the installation.
• Ensure that any required third-party software is installed.
• Make sure that the server machine has enough swap space. (As a rough guide, swap space should
be two to three times the physical memory space.) Refer to the documentation for your operating
system.
1. Run the Win32qsserverinstall.exe which is available in the /Setup folder on the release
media. Ensure you right-click and select Run as Administrator.
2. Follow the installer instructions, clicking Next (or entering 1 in the console-based installer) to proceed
though the steps.
3. When you reach the end of the installation, click Finish (or enter 3) to quit the InstallShield wizard.
Note: After installation, you should review ownership and permissions of all subdirectories of the shared
directory, to ensure that they comply with your security standards.

Setting permissions for shared drives
Following a server or Desktop installation, the <pmhome>/shared/users directory is only writable by
root or system (where <pmhome> is the Portrait Miner installation directory). To ensure that only authorized
users have access, do one of the following:
• If you have created a group, mineruser, for Portrait Miner users, make the shared/users directory
writable by members of that group.
• You cannot make a linked copy of a focus unless you have permission to write to the "eXTRa" directory
of that focus. Therefore, for users to be able to save copies of foci from a shared directory, they must
either make full copies, or the shared directory must have write permissions that propagate to subfolders
and files.
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Configuring Windows Firewall with Advanced
Security
If Windows Firewall is turned on on your server, you need to configure it with inbound rules for Portrait
Miner processes.
You must be logged in as an administrator.
1.
2.
3.
4.

Start the Windows Firewall with Advanced Security application.
Highlight Inbound Rules and click on Actions>New Rule.
Create a Program rule type, and click on Next.
Browse to <pmhome>\server\jre\<arch>\<Java version>\bin (where <pmhome> is the
Portrait Miner installation directory, and <arch> is win64 or win32), and select jmasterlauncher.exe.

5. Choose Allow the connection and click Next.
6. Choose when this rule applies.
7. Provide a name for the rule, for example, use the name of the executable.
Repeat this to create rules for jqsserver.exe and jusersession.exe.

Integrating Portrait Miner with the Portrait Software
suite
Installing the PSSConnector extension for Portrait Miner
The Portrait Shared Services' connection extension (PSSConnector) is a component that is included in
all Portrait Miner 7.0A installations to support integration with the following Portrait Suite applications:
• Portrait Dialogue
• Portrait Explorer
• Portrait Interaction Optimizer.
The PSSConnector must be configured to publish and retrieve analytics content to and from the Portrait
Shared Repository (PSR) via Portrait Shared Services (PSS).
Configure Portrait Miner to point to a pre-installed version of the Portrait Shared Services. Edit the
file: <PMHOME>/ext/PSSConnector/pss.properties to include the text <service=URL of
the Portrait Shared Services>, for example: service=http://MY-SERVER/PortraitSharedServices
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Installation datasheets

Installation datasheets
Interaction Optimizer datasheet
Use this datasheet when installing Portrait Interaction Optimizer.
Installation item

Recommended or default value

IO installation type

Complete

Portrait Shared Repository database name PortraitPSR
(Portrait HQ)
Portrait Data Warehouse database name PortraitDW

70

IO configuration repository owner

Name of your organization.

IO configuration repository administrator

Superuser

IO configuration repository administrator
password

Password

IO database server administrator login

To be determined at time of install

IO database creation method

create new database

IO SQL server instance

To be determined at time of install

IO database name

InteractionOptimizer

IO database authentication method

OS authentication

IO database collation

Server collation

IO database data file location

C:\Databases\Data

IO database log file location

C:\Databases\Data

IO database additional features

Customised

IO database project code

blank

IO database implementation scripts

Check Execute Implementation Scripts. Browse to
Installation\Foundation Database
scripts\cre_imp_db.txt on IO release media

IO database implementation version

IO 5.4, or whatever version of IO you are installing

IO database temp working directory

C:\PST_Database_Install\Files_<date>

IO database login

To be determined at the time of install.

IO transient database

uncheck all options
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Installation item

Recommended or default value

IO services start-up options

Uncheck Manual service start-up. Check Enable
Perfmon Counting

IO web site

Default web site

IO Web Services
Installation item

Recommended or default value

IO sql server

To be determined at time of install

IO database name

InteractionOptimizer

Windows user account for anonymous
access

To be determined at time of install

Password for anonymous access account To be determined at time of install
Foundation installation folder

C:\program files\pst\portrait

Foundation system name

MyPortrait

Database login mode

Windows

Database login user

To be determined at time of install (if using SQL login mode)

Login user's password

To be determined at time of install (if using SQL login mode)

Portrait Foundation datasheet
Use this datasheet when installing Portrait Foundation 'core software' with Portrait Interaction Optimizer.
Installation item

Recommended or default value

Foundation service account

To be determined at time of install.

Portrait HQ datasheet
Use this datasheet when installing Portrait HQ with Portrait Interaction Optimizer. We recommend you
print this checklist and fill in all information prior to completing your installation/upgrade.
Installation item

Recommended or default value

Installation or destination folder

C:\Program Files\PST\Portrait Shared Server\

Installation type

Complete

Database user domain

To be determined at time of install

Database user name

To be determined at time of install

Database login user's password

To be determined at time of install
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SharePoint / Interaction Optimizer install considerations
Installation item

Recommended or default value

HQ SQL server instance

To be determined at time of install

Portrait Shared Repository database name PortraitPSR
Portrait Data Warehouse database name PortraitDW
Portrait HQ Service Account domain

To be determined at time of install

Portrait HQ Service Account name

To be determined at time of install

Portrait HQ Service Account password

To be determined at time of install

Portrait Dialogue server address

http://localhost/mhdialogserverapi

Portrait Dialogue server instance

Default

Portrait SharePoint services address

http://localhost/Portrait

Currency symbol

To be determined at time of install

Foundation Decisions web service address http://localhost/DecisionsWCFWebService/DecisionsWebService.svc
Foundation IO Bridge web service address http://localhost/IOBridgeWCFWebService/IOBridgeWebService.svc
Report server URL

Default = http://localhost/ReportServer

SharePoint / Interaction Optimizer install
considerations
If you install SharePoint (optional) and Portrait Shared Server together on a single machine, then they
have to run within separate web sites. You will have to decide which of them will run on the default port
of 80, and which of them will run on some other port. Then carry out the following steps during the install:
• If you are happy to run SharePoint on port 80, and the Portrait Shared Server applications (and any
other web applications on the server) on some other site, then you will have to modify the properties
of the IIS "Default Web Site" to change its port to something other than 80, then start it running. Alternatively (and this is the recommended configuration), if you would rather run the Portrait Shared Server
applications (and any other web applications on the server) on the default port 80, and run SharePoint
on some other port. Then you will have to start the IIS "Default Web Site", as it will have been stopped
when you installed SharePoint. If PCM is already installed on the “Default Web Site”, then it’s a good
idea to install SharePoint to a new website called “SharePoint - 8080” on port 8080. This is done under
the SharePoint installation.
• Define "Alternate Access Mappings" for each URL that SharePoint needs to be accessible on. For instance, if you have changed the port that SharePoint is running on, then you must edit the mapping
that referred to the old port, to give it the new port instead. Additionally, you should create extra mappings for the fully-qualified domain-name variants of each internal URL if you need the SharePoint site
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to be accessible via a fully-qualified domain name (as by default SharePoint only provides mappings
for the simple unqualified form).
• To set up these mappings, run the SharePoint Central Administration tool (from "Administrative Tools"
on the start menu), go to the "Operations" menu, and select "Alternate Access Mappings".
For example, if you have changed your SharePoint to run on myserver:8090 instead of myserver:80,
and you also want it to be accessible as myserver.mydomain.mycompany.com, then you need to:
• edit the existing http://myserver:80 mapping to change its port to 8090.
• edit that mapping again to define an 'intranet' or 'internet' fully-qualified equivalent URL http://myserver.mydomain.mycompany.com:8090.
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